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Assalamu’alaikum Warahmatullahi Wabarakatuh. 
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pada seorang penulis buku yang istimewa ini. Dia adalah Mira Septema, 

S.Stat, seorang yang smart dan berbakat dalam berkarya. Seorang yang 
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pembaca, serta memberikan wawasan yang berharga dalam menghadapi 
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oleh pemula hingga pengguna tingkat lanjut dari Dashboard Excel. 

Saya ingin mengucapkan terima kasih kepada Mira Septema atas usahanya 

dalam penulisan buku ini. Buku ini lebih dari sekedar panduan dalam 

pengolahan data dan informasi, namun dapat menginspirasi pembacanya 

sebagai sarana pembelajaran yang efektif. Semoga buku ini dapat 

memberikan kontribusi positif pada pemahaman dan keterampilan Anda 

dalam memanfaatkan Excel untuk keperluan analisis data. 

Wassalamu’alaikum Warahmatullahi Wabarakatuh. 

 

 

 



ii  

Banjarbaru, 16 Januari 2024 

Kasubid Pemindahtanganan, Penghapusan, 

dan Pemusnahan Barang Milik Daerah 

Provinsi Kalimantan Selatan 

 

 

 

 

  Muhammad Hidayatullah, S.Kom., M.Ec.Dev 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



iii  

PRAKATA 

Assalamu’alaikum Warahmatullahi Wabarakatuh, salam sejahtera bagi 

para pembaca, 

Buku ini merupakan sebuah eksplorasi mendalam ke dalam dunia 

penyajian data melalui visualisasi data dengan menggunakan dashboard 

interaktif berbasis Microsoft Excel. Dalam era di mana data menjadi inti 

keputusan strategis, pengembangan keterampilan untuk menyajikan dan 

memahami data secara efektif adalah suatu keharusan. Buku ini hadir 

sebagai panduan komprehensif, membawa pembaca dari dasar hingga 

pada pemahaman yang mendalam mengenai konsep-konsep esensial dan 

teknik canggih dalam mengoptimalkan potensi Microsoft Excel sebagai alat 

analisis data yang hebat. 

Pertama-tama, pembaca akan dibimbing melalui konsep dasar visualisasi 

data, dari pemahaman kebutuhan analisis hingga teknik-teknik penyajian 

yang paling efektif. Kami percaya bahwa penguasaan aspek ini akan 

memberikan landasan yang kuat untuk memahami kompleksitas data dan 

membuat keputusan yang informasional. 

Selanjutnya, buku ini menggali lebih dalam ke dalam dunia dashboard 

interaktif, menunjukkan langkah-langkah praktis dan teknik desain yang 

dapat digunakan untuk menciptakan tampilan data yang dinamis dan 

responsif. Pembaca akan dibimbing melalui pembuatan grafik interaktif, 

penggunaan tabel dinamis, dan penyusunan elemen-elemen desain yang 

memikat hati. 

Tidak ketinggalan, kami ingin menyampaikan terima kasih sebesar-

besarnya kepada semua pihak yang telah mendukung dan berkontribusi 

dalam proses penulisan buku ini. Semoga buku ini bukan hanya menjadi 

referensi berharga tetapi juga menjadi inspirasi bagi pembaca untuk terus 

mendalami dan mengasah keterampilan mereka dalam penyajian dana 

melalui visualisasi data. 

Buku ini bukan hanya untuk ahli statistik, tetapi juga untuk pengusaha, 

analis data, dan siapa pun yang ingin mengoptimalkan penggunaan 

Microsoft Excel untuk merumuskan keputusan yang lebih cerdas melalui 
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visualisasi data yang kuat dan interaktif. Jelajahi keajaiban variabel dan 

data, dan temukan potensi sebenarnya dalam setiap angka! 

Selamat menikmati perjalanan pengetahuan yang menarik ini, dan semoga 

buku ini dapat menjadi panduan yang berharga dalam menjelajahi dunia 

visualisasi data yang semakin dinamis.  

 

Banjarbaru, 16 Januari 2024 

 

 

Tim Penulis 
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SINOPSIS 

Data merupakan elemen penting dalam pengambilan suatu keputusan. 

Pengolahan data yang memberikan penyajian dalam bentuk visualisasi 

tentunya diperlukan agar memudahkan dalam melihat gambaran akhir 

suatu data yang diamati.  

Buku ini memberikan sekilas penjelasan pada konsep variabel dan data, 

menjelaskan secara umum sifat dan bentuk dari variabel data yang akan 

menjadi sumber utama dalam pengumpulan dan interpretasi data. 

Pembaca akan dibimbing melalui pemahaman mengenai jenis variabel dan 

juga contohnya untuk memahami karakteristik data. 

Setelah penjelasan tentang konsep variabel dan data, maka dipaparkan juga 

tentang konsep visualisasi data. Visualisasi data bukan sekadar 

sekumpulan grafik dan diagram. Buku ini membahas seni di balik 

visualisasi data dengan menggali teknik-teknik yang memastikan informasi 

dapat disajikan dengan jelas dan efektif. Visualisasi dilakukan dengan 

menggunakan dashboard, dimana teks, pola, dan korelasi yang tidak 

terdeteksi dapat dengan mudah divisualisasikan dengan menggunakan 

perangkat lunak visualisasi beragam metode visualisasi data yang dapat 

meningkatkan pemahaman dan pengambilan keputusan. 

Salah satu software yang mudah di akses yaitu Microsoft Excel. Selain 

penggunaan yang mudah, fitur-fitur yang ada pada Microsoft Excel 

memudahkan pengguna untuk mengolah data dan dapat disajikan secara 

kreatif dalam bentuk visualisasi bergerak, yaitu dashboard interaktif. Untuk 

itu, buku ini akan menghadirkan langkah-langkah mengolah data menjadi 

sajian visualisasi dashboard interaktif berbasis Microsoft Excel secara 

sederhana, sehingga buku ini dapat menjadi langkah awal pembelajaran 

dalam penelusuran informasi dan eksplorasi data. Pada buku ini juga 

didapatkan penjelasan terkait komponen pembuatan dashboard interaktif 

dalam Micsoroft Excel serta tahap-tahap yang praktis dalam proses 

pembuatannya. Penjelasan langkah per langkah dari penginputan data, 

pengolahan data, hingga pembuatan desain kreatif dalam visualisasi data. 

Teknik canggih dalam pembuatan grafik interaktif, pengaplikasian filter 

data yang tepat, dan penerapan tata letak yang efisien akan diulas secara 
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menyeluruh, membekali pembaca dengan keterampilan praktis yang dapat 

langsung diterapkan dalam pengaturan dunia nyata.  

Beranjak dari dasar hingga tingkat lanjut, pembaca akan diperkenalkan 

pada kekuatan visualisasi data yang dapat dihasilkan melalui Microsoft 

Excel, membuka mata pada potensi yang belum tergali sebelumnya. 

Dengan mengeksplorasi dashboard interaktif, bukan hanya sekadar 

panduan teknis, tetapi juga perjalanan eksplorasi yang memperkaya 

pengetahuan pembaca dan membuka wawasan baru dalam memahami 

data dengan lebih menyeluruh. 
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BAB I  

PENDAHULUAN 

1.1. Variabel dan Data 

Menurut Mendehnhall et al (2013) variabel adalah suatu karakteristik 

yang berubah atau bervariasi seiring berjalannya waktu dan/atau untuk 

individu atau objek yang berbeda dalam pertimbangan. Variabel penelitian 

terdiri menjadi tiga kategori yaitu: 

a. Univariate Data 

Data univariat dihasilkan ketika satu variabel diukur dalam satu 

percobaan. 

b. Bivariate Data 

Data bivariat dihasilkan ketika dua variabel diukur dalam percobaan. 

c. Multivariate Data 

Data multivariat dihasilkan ketika lebih dari dua variabel diukur dalam 

satu percobaan.  

Menurut Agresti et al (2017) berdasarkan sifat nilai datanya, variabel 

bisa terbagi menjadi dua yaitu: 

a. kuantitatif (numerik)  

Suatu variabel disebut kuantitatif apabila pengamatan terhadap 

variabel tersebut mengambil nilai-nilai numerik yang mewakili besaran 

variabel yang berbeda. Contoh variabel data yang bersifat kuantitatif 

adalah umur, jumlah saudara kandung, pendapatan tahunan, dan 

jumlah tahun pendidikan yang diselesaikan. Variabel kuantitatif dapat 

dibagi lagi menjadi dua bentuk yaitu: 

- Variabel Diskrit 

Suatu variabel kuantitatif bersifat diskrit apabila nilai-nilai yang 

memungkinkan membentuk sekumpulan angka-angka secara 

terpisah seperti 0, 1, 2, 3, dan seterusnya. 

- Variabel Kontinu 

Suatu variabel kuantitatif bersifat kontinu apabila nilai-nilai yang 

memungkinkan membentuk sebuah interval. Variabel kontinu 

tidak terdiri dari sekumpulan angka-angka terpisah, melainkan 

nilai yang tak terbatas. Misalnya adalah jumlah waktu yang 



2  

dibutuhkan untuk menyelesaikan suatu tugas yang bernilai 

2.496631… jam. 

b. kategorik (Kategori) 

Suatu variabel disebut kategorikal jika setiap observasi termasuk dalam 

salah satu dari sekumpulan kategori yang berbeda. Contoh variabel data 

yang bersifat kategorik adalah jenis kelamin (perempuan dan laki-laki), 

agama (Katolik, Buddha, Islam, Protestan, Hindu, dan lainnya), dan jenis 

tempat tinggal (rumah, kondominium, apartemen, asrama, dan lainnya. 

1.2. Visualisasi Data  

Visualisasi data Menurut Mihaly (2008) didefinisikan sebagai 

berbagai jenis cara untuk membuat gambar, diagram atau animasi dengan 

tujuan untuk mengkomunikasikan sebuah pesan/informasi (Ernawati, 

2012). Visualisasi dapat dilakukan dengan menggunakan dashboard, dimana 

teks, pola, dan korelasi yang tidak terdeteksi dapat dengan mudah 

divisualisasikan dengan menggunakan perangkat lunak visualisasi 

(Asmiatun et al., 2020). 

Dalam salah satu panduan oleh Dr. Andrew Abela dalam metode 

Extreme Presentation (Abela, 2008). Presentasi atau visualisasi data dapat 

dibagi menjadi empat macam sesuai dengan kebutuhan informasinya 

diantaranya adalah perbandingan (comparison), hubungan (relationship), 

komposisi (composition) dan distribusi (distribution). 

a. Bentuk Perbandingan 

Visualisasi data dalam bentuk perbandingan (comparison) 

merupakan visualisasi yang berfungsi untuk membandingkan data 

antara satu variabel dengan variabel lainnya. Selain itu juga, visualisasi 

ini juga dapat digunakan untuk menentukan nilai tertinggi maupun nilai 

terendah dari data serta dapat pula membandingkan beberapa kategori 

dalam suatu variabel data. Bentuk visualisasi yang tepat digunakan 

dengan tujuan membandingkan data adalah Bar Chart, Line Chart dan 

Combo Chart (Srivastava et al., 2009). 

b. Bentuk Hubungan 

Visualisasi data dalam bentuk hubungan (relationship) merupakan 

visualisasi yang berfungsi untuk menunjukkan bagaimana hubungan 

antara satu variabel dengan variabel lainnya. Relationship chart ini 

memungkinkan pula untuk memperlihatkan bagaimana outliers, 
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korelasi, dan cluster dari suatu data. Bentuk visualisasi yang tepat 

digunakan dengan tujuan menunjukkan hubungan data adalah Scatter 

Plot dan Bubble Chart (Abela, 2008). 

c. Bentuk Komposisi 

Visualisasi data dalam bentuk komposisi (composition) merupakan 

visualisasi yang berfungsi untuk memperlihatkan komposisi dari suatu 

komponen nilai dibandingkan dengan nilai total dari keseluruhan data. 

Composition Chart dapat bersifat statis artinya fungsi dari chart tersebut 

mampu menunjukkan komposisi dari nilai total saat ini, atau dapat pula 

bersifat non-statis artinya mampu menunjukkan bagaimana komposisi 

dari nilai tersebut berubah seiring dengan berjalannya waktu. Bentuk 

visualisasi yang tepat digunakan dengan tujuan menunjukkan 

komposisi data adalah Pie Chart, Treemaps dan Waterfall Chart (Gallagher, 

2020).  

d. Bentuk Distribusi 

Visualisasi data dalam bentuk distribusi (distribution) merupakan 

visualisasi yang berfungsi untuk mengeksplorasi atau menunjukkan 

bagaimana suatu nilai dalam data tersebut dikelompokkan. Distribution 

Chart dapat pula memperlihatkan bagaimana bentuk dari suatu data, 

atau bagaimana rentang nilai dari data serta bagaimana pula 

kemungkinan adanya outlier pada suatu data. Bentuk visualisasi yang 

tepat digunakan dengan tujuan menunjukkan distribusi data adalah 

Histogram, Scatter Plot, dan Box Plot (Bertini et al., 2007) 

1.3. Komponen Pembuatan Dashboard Berbasis Microsoft Excel 

Mengutip dari laman blog Sebastian. J (2018), terdapat beberapa 

komponen dalam pembuatan dashboard menggunakan PivotTable seperti 

sebagai berikut: 

a. Pivot Table: Penyajian hasil analisis dan pengolahan data dalam bentuk 

tabel 

b. Pivot Chart: Penyajian hasil analisis dan pengolahan data dalam bentuk 

visualisasi grafik 

c. Insert Slicer: Komponen yang berfungsi sebagai filter/penyaring dalam 

bentuk penyajian tabel yang bisa di klik. 

d. Insert Timeline: Komponen yang berfungsi sebagai filter/penyaring 

dalam bentuk penyajian tabel yang bisa di klik berdasarkan waktu. 
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e. Hyperlink: Komponen pembantu penyisipan suatu link terkait lembar 

kerja/data yang bisa dimasukkan ke bagian bagan tertentu. 
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BAB II  

PEMBUATAN DASHBOARD 
 

2.1. Input Data 

Tahapan pertama yang dilakukan adalah dengan melakukan input 

data. Data yang diperoleh dalam pembuatan dashboard bisa dari data yang 

disajikan oleh website-website maupun publikasi dari internet hingga 

instansi tempat data yang ingin dilakukan analisis. Dalam hal 

pembelajaran, terdapat beberapa rekomendasi website tempat mengambil 

data yang terpublikasi dan merupakan data nyata. Berikut diberikan 

beberapa referensi pengambilan data: 

a. Badan Pusat Statistik (bps.go.id) 

b. Satu Data Indonesia (data.go.id) 

c. Our World in Data (ourworldindata.org) 

d. World Bank Data (data.worldbank.org) 

e. Kaggle (kaggle.com) 

f. Badan Meteorologi, Klimatologi, dan Geofisika (bmkg.go.id) 

g. Google Scholar (berbentuk jurnal/skripsi) 

Data yang digunakan dalam pembuatan modul pembelajaran ini 

berasal dari ourworldindata.org. Data yang digunakan merupakan data 

“kematian per 100.000 orang akibat polusi udara di wilayah Asia pada 

tahun 1990-2019”. Data ini berisikan kematian per 100.000 orang akibat 

polusi udara yang memiliki 3 kategori yaitu: indoor, outdoor, dan ozone. 

Pengambilan data di Wilayah Asia dengan rentan waktu pada tahun 1990-

2019. Adapun langkah-langkah untuk memasukkan data sebagai berikut: 

1. Buka laman resmi penyedia data (https://ourworldindata.org/) dan 

masuk ke dalam laman, kemudian klik menu Browse by topic > Health 

https://ourworldindata.org/
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> Air Pollution > pilih topik (Deaths rates from air pollution are falling 

mainly due to improvements in indoor pollution)  

 

Gambar 1. Laman Website OurWorldindata 

 

Gambar 2. Laman Utama Website OurWorldindata 
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Gambar 3. Laman Topik yang dicari 

 

Gambar 4. Laman Tampilan Data 
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2. Lakukanlah pengunduhan pada data yang ingin digunakan dengan klik 

DOWNLOAD > Full data (CSV) 

 

Gambar 5. Petunjuk Unduh (DOWNLOAD) 

 

Gambar 6. Petunjuk Unduh Full data (CSV) 
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3. Bersihkan data hingga data siap pakai, bisa menghapus, mengganti 

informasi data, dan lain-lain. 

 

Gambar 7. Tampilan Data di Microsoft Excel 

4. Pada bagian penamaan kolom pada data juga dilakukan perubahan 

dengan mengubah kalimat yang awalnya masih panjang menjadi 

kategori saja agar memudahkan dalam penyajian informasi pada 

dashboard nantinya. 

 

Gambar 8. Pergantian Nama Kategori Data 

5. Pada modul pembelajaran ini hanya berfokus pada Wilayah Asia, 

sehingga untuk wilayah-wilayah yang di luar kawasan Asia pada tabel 
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dihapuskan dengan cara blok tabel yang ingin dihapus > klik kanan 

pada tab > Delete > Shift cells up > OK. 

Informasi Tambahan Terkait Data Negara-negara di Wilayah Asia: 

Asia Tengah: Kazakhstan, Kyrgyzstan, Tajikistan, Turkmenistan, 

Uzbekistan 

Asia Timur: Tiongkok, Hongkong, Jepang, Taiwan, Makau, Mongolia, 

Korea Selatan, Korea Utara 

Asia Utara: Rusia 

Asia Tenggara: Brunei Darussalam, Kamboja, Indonesia, Laos, Malaysia, 

Myanmar, Filipina, Singapura, Thailand, Timor Leste, Vietnam 

Asia Selatan: Afghanistan, Bangladesh, Bhutan, India, Maladewa, 

Nepal, Pakistan, Sri Lanka 

Asia Barat: Arab Saudi, Armenia, Azerbaijan, Bahrain, Georgia, Iran, 

Irak, Kuwait, Lebanon, Oman, Palestina, Qatar, Siprus, Turki, Uni Emirat 

Arab, Yaman, Yordania 

 

Gambar 9. Petunjuk Menghapus Baris 
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Gambar 10. Petunjuk Lanjutan (Menghapus Baris) 

6. Adapun data yang telah dibersihkan serta siap untuk diolah 

ditampilkan pada Gambar 11 berikut. 

 

Gambar 11. Tampilan Data Siap Olah 

7. Apabila sulit untuk menemukan data yang ingin diolah pada modul 

pembelajaran ini maka bisa menggunakan link tautan sebagai berikut: 

https://ourworldindata.org/air-pollution#death-rates-from-air-

pollution-are-falling-mainly-due-to-improvements-in-indoor-pollution 

 

https://ourworldindata.org/air-pollution#death-rates-from-air-pollution-are-falling-mainly-due-to-improvements-in-indoor-pollution
https://ourworldindata.org/air-pollution#death-rates-from-air-pollution-are-falling-mainly-due-to-improvements-in-indoor-pollution
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2.2. Model Dashboard Pertama (Manual) 

Dalam pembuatan dashboard sederhana, dapat dilakukan 

menggunakan fungsi SUMIFS yang mana fungsinya adalah menjumlahkan 

sesuatu dengan beberapa logika sebagai syarat dalam menjumlahkan. 

1. Bukalah Software Microsoft Excel 365 Version yang berisi database  

 

Gambar 12. Tampilan Ms. Excel Berisi Database 

2. Buatlah Sheet baru dengan menekan tombol “+” > Klik kanan > Rename 

(beri nama Dashboard) 

 

Gambar 13. Petunjuk Menambahkan Sheet 
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Gambar 14. Petunjuk Mengganti Nama Sheet 

 

Gambar 15. Tampilan Sheet Baru (Dashboard) 

Menu Sheet dengan Nama Dashboard akan menjadi wadah dalam 

pembuatan Dashboard interaktifnya. 

3. Buatlah judul pada Dashboard yang ingin diolah, kemudian blok 

beberapa tabel baris di sampingnya dan untuk menyatukan dengan tabel 

lainnya pilih menu Home > Merge.
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Gambar 16. Petunjuk Penulisan Judul 

 

Gambar 17. Petunjuk Merge Cell

 

 

Gambar 18. Tampilan Akhir Judul 
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4. Pada kasus ini diberikan pilihan berupa jumlah kematian per tahun dari 

tahun 1990-2019, sehingga dilakukannya pembuatan opsi pilihan di 

Dashboard. 

 

Gambar 19. Pembuatan Tempat Menulis Tahun 

5. Buatlah tabel data berdasarkan unit yang ingin diamati, pada kasus ini 

yaitu negara-negara di Asia dengan 4 variabel yaitu Polusi udara indoor, 

outdoor, total (indoor & outdoor) dan ozone dengan menuliskannya sesuai 

dengan Gambar 20. 

 

Gambar 20. Pembuatan Tabel Secara Manual 
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6. Isilah data pada setiap entry yang kosong dan agar data berubah sesuai 

tahunnya maka lakukanlah SUMIFS pada baris di negara Afghanistan 

pada kolom Indoor. 

>=SUMIFS(Database!$D$2:$D$1531;Database!$A$2:$A$1531;Dashboa

rd!$C7;Database!$C$2:$C$1531;"<="Dashboard!$C$3). 

Pada sintaks: 

- Berlabel kuning merupakan rentang sel yang akan di evaluasi 

menurut kriteria (pada kasus ini yaitu indoor) 

- Berlabel hijau merupakan kriteria pertama yang menjadi evaluasi 

(pada kasus ini yaitu wilayah di database) 

- Berlabel biru merupakan kriteria kedua yang menjadi evaluasi (pada 

kasus ini yaitu wilayah yang ada di Dashboard), sehingga antara 

wilayah di database dengan di dashboard menjadi sama. 

- Berlabel ungu merupakan kriteria ketiga yang menjadi evaluasi 

(pada kasus ini berbentuk tahun) 

- Berlabel merah merupakan kriteria keempat yang menjadi evaluasi 

(pada kasus ini yaitu tahun pada kolom pilihan tahun yang akan di input 

di dashboard harus sama dengan tahun pada database sehingga output 

sesuai) 

- Fungsi SUMIF untuk menjumlahkan nilai dalam satu rentang yang 

memenuhi kriteria yang Anda tentukan. Dikutip dari laman Microsoft 

dengan link: https://support.microsoft.com/id-id/office/sumif-fungsi-

sumif-169b8c99-c05c-4483-a712-1697a653039b 

Sintaks 

SUMIF(range, criteria, [sum_range]) 

Sintaks fungsi SUMIF memiliki argumen berikut: 

▪ Range (Rentang). Rentang sel yang akan Anda evaluasi menurut 

kriteria. Sel di setiap rentang harus merupakan angka atau nama, 

https://support.microsoft.com/id-id/office/sumif-fungsi-sumif-169b8c99-c05c-4483-a712-1697a653039b
https://support.microsoft.com/id-id/office/sumif-fungsi-sumif-169b8c99-c05c-4483-a712-1697a653039b
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array, atau referensi yang berisi angka. Sel kosong atau nilai teks 

diabaikan. Rentang yang dipilih dapat berisi tanggal dalam format 

Excel standar (contoh di bawah). 

▪ Criteria (Kriteria). Kriteria dalam bentuk angka, ekspresi, referensi 

sel, teks, atau fungsi yang menentukan sel mana yang akan 

ditambahkan. Karakter wildcard dapat disertakan - tanda tanya (?) 

untuk mencocokkan karakter tunggal apa pun, tanda bintang (*) 

untuk mencocokkan urutan karakter apa pun. Jika Anda ingin 

menemukan tandatanya atau tanda bintang, ketikkan tilde (~) 

sebelum karakter. 

Misalnya, kriteria dapat dinyatakan sebagai 32, ">32", B5, "3?", "apple*", 

"*~?", atau TODAY(). 

Penting: Kriteria teks atau kriteria apapun yang mencakup simbol 

logika atau matematika harus disertakan dalam tanda kutip ganda ("). 

Jika kriteria adalah numerik, tanda kutip ganda tidak diperlukan. 

▪ Sum_range. Sel aktual untuk ditambahkan, jika Anda ingin 

menambahkan sel yang lain dari yang sudah ditentukan dalam 

argument range. Jika argumen sum_range dihilangkan, Excel 

menambahkan sel yang ditentukan dalam argumen range (sel yang 

sama di mana kriteria diterapkan). 

 

 

 

 

 

 

 

 



18  

Indoor (Database!$D$2:$D$1531) 

 

Gambar 21. Pengisian Entry Indoor 

Untuk mengisi entry pada kolom outdoor, total, dan ozone cukup 

mengganti rentan data amatan saja menyesuaikan pada database. 

Outdoor (Database!$E$2:$E$1531) 

 

Gambar 22. Pengisian Entry Outdoor 
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Total (Database!$E$2:$E$1531) 

 

Gambar 23. Pengisian Entry Total 

Ozone (Database!$F$2:$F$1531) 

 

Gambar 24. Pengisian Entry Ozone 

7. Blok semua elemen yang ada di baris Afghanistan dan double klik pada 

ujung baris, maka semua entry data akan terisi. 

 

Gambar 25.  Pengisian Entry Otomatis 
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Gambar 26. Tampilan Hasil Semua Entry Terisi 

8. Isilah entry pada baris Asia dengan sintaks SUM (Untuk penjumlahan 

semua elemen baris). Ketikkan =Sum() > blok data yang ingin 

dijumlahkan. 

 

Gambar 27. Penjumlahan Data Menggunakan “SUM” 

9. Klik hasil Sum > Tarik bagian ujung baris ke samping > entry 

disampingnya akan terisi 
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Gambar 28. Pengisian Entry Otomatis 

 

Gambar 29. Pengisian Entry Otomatis dengan Menarik Blok Ke Samping 

 

Gambar 30. Tampilan Hasil Akhir Pembuatan Tabel 
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10. Cobalah untuk mengisi tahun pada menu yang telah disediakan untuk 

pilihan tahun sebelumnya. Apabila proses pembuatan berhasil maka 

entry-entry tabel yang sebelumnya bernilai nol akan berubah menjadi 

totalan per tahun tersebut (Misal: 1990) 

 

Gambar 31. Percobaan Tabel Bergerak 

11. Buatlah grafik visualisasi sesuai kebutuhan dan karakteristik data (Pada 

kasus ini karena data amatan berupa wilayah, maka digunakan Maps 

Chart sebagai bentuk visualisasi). Pilih Insert > Maps > Filled Map > 

Output Grafik. 

 

Gambar 32. Pembuatan Grafik MAPS 
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Gambar 33. Pembuatan Grafik (Filled Map) 

 

Gambar 34. Tampilan Grafik 

12. Untuk memunculkan gambar grafik, pilih menu Select Data >Select 

Data Source > Edit > Series Name (Untuk Nama grafik) > Series Value 

(nilai amatan, pada kasus ini total kematian) > OK. 

 

Gambar 35. Penyesuaian Grafik dengan Data 
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Untuk menyesuaikan grafik terhadap data, maka dilakukan pengeditan 

pada menu edit sesuai pada Gambar 36 berikut. 

 

Gambar 36. Pengeditan Data 

13. Sesuaikan data dengan grafik dengan cara mengisi series name dengan 

judul Grafik, kemudian mengisi series values dengan nilai (Blok semua 

data dari Indoor, Outdoor, dan Ozone) > OK. 

 

Gambar 37. Tampilan Edit Series 
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Gambar 38. Tampilan Grafik Akhir 

14. Lakukanlah pengeditan pada tampilan Grafik dengan menekan symbol 

“+”, dimana Chart Elements berisi: 

a. Chart Title: Tampilan judul grafik 

b. Data Labels: Tampilan label data pada grafik 

c. Legend: Warna penanda data pada grafik 

 

Gambar 39. Tampilan Chart Elements 

15. Untuk melakukan desain warna grafik, maka tekan ikon Brush, dimana 

tersedia tampilan Style dan Color 
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Gambar 40. Tampilan Desain Warna pada menu Style 

 

Gambar 41. Tampilan Desain Warna pada menu Color 

16. Hasil akhir pada proses pembuatan dashboard ini dapat dilihat pada 

Gambar 42 sebagai berikut. 
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Gambar 42. Tampilan Dashboard 
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 2.3. Model Dashboard Kedua (Pivot Table) 

Pembuatan dashboard juga bisa dilakukan dengan menggunakan 

PivotTable dan PivotChart. Proses ini lebih mudah dibandingkan dengan 

model sebelumnya, kemudian hasil yang ditampilkan pun lebih interaktif 

dan lebih bagus.Langkah-langkah pembuatan Dashboard Interaktif Model 

2 dengan Menggunakan Microsoft Excel adalah sebagai berikut. 

OLAH DATA 

1. Siapkan data yang ingin diolah untuk disajikan dalam bentuk dashboard 

interaktif, kemudian klik kanan pada tab > Rename > beri nama sheet 

“DATABASE”. 

 

Gambar 43. Pengeditan Nama Sheet 
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Gambar 44. Tampilan Sheet dengan Nama Database 

2. Blok bagian data yang ingin diolah lalu Ctrl + T (Untuk menampilkan 

kotak dialog) > OK.   

 

Gambar 45. Pembuat Kotak Dialog 

 

PROSES PIVOT TABLE PADA KASUS PER WILAYAH 

3. Tahap selanjutnya adalah untuk melakukan proses PivotTable dengan 

cara pilihlah menu Insert > Pivot Table > Create PivotTable > OK. 
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Gambar 46. Pembuatan PivotTable 

 

Gambar 47. Tampilan Create PivotTable 

Pada kotak Create PivotTable didapatkan tampilan sajian informasi 

sebagai berikut: 

● Table/Range: merupakan menu isian untuk data yang diolah 

● Pada Choose where you want the PivotTable report to be place: 

o New Worksheet: Hasil PivotTable akan diletakkan pada sheet baru. 

o Existing Worksheet: Hasil PivotTable akan diletakkan pada lokasi 

yang diinginkan (isi pada kolom location dengan memblok 

tabel/halaman pada excel). 
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4. Apabila telah terbuka sheet baru dengan tampilan PivotTable, maka isi 

bagian PivotTable Fields sesuai dengan output yang diinginkan. Pada 

modul pembelajaran ini diisi dengan ketentuan: 

● Choose Fields to add to report (untuk mengisi data yang dipilih untuk 

ditampilkan pada PivotTable): Wilayah, Tahun, Indoor, Outdoor, dan 

Ozone. 

● FILTERS (penyaring): Wilayah sebagai bentuk pembagian kelompok 

kategori. 

● COLUMNS (pengisian kolom pada tabel): Nilai jumlahan dari setiap 

kategori wilayah. 

●  ROWS (pengisian baris pada tabel): Tahun yang di isi pada setiap 

baris pada tabel 

● VALUES (pendefinisian nilai-nilai yang akan dimasukkan pada 

bagian COLUMNS): Nilai jumlah indoor, outdoor, dan ozone. 

 

Gambar 48. Tampilan PivotTable Fields 

Informasi tampilan sajian PivotTable Fields adalah sebagai berikut: 

● FILTERS: Penyaringan data berdasarkan karakteristik yang 

diinginkan atau kategori data 

● COLUMNS: Mengelola data dengan tampilan isian kolom pada 

tabel 
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● ROWS: Mengelola data dengan tampilan isian baris pada tabel  

● VALUES: Penyajian data dalam bentuk nilai 

 

Gambar 49. Tampilan Value Field Settings 

Terdapat beberapa pilihan ragam output yang disajikan sebagai 

VALUES, diantaranya berikut: 

o Sum: Jumlah data pada kolom 

o Count: Jumlah Cell data (berisi maupun tidak) pada kolom 

o Average: Rata-rata data pada kolom  

o Max: Nilai maksimal data pada kolom 

o Min: Nilai Minimum data pada kolom 

o Product: Produk 

o Count Numbers: Jumlah Cell data (berisi angka saja) 

o StdDev: Standar Deviasi  

o StdDevp: Standar Deviasi Populasi 

o Var: Variansi 

o Var p: Variansi Populasi 

PROSES PIVOT CHART (PEMBUATAN GRAFIK) 

5. Apabila setiap elemen pada PivotTable Fields sudah diisi semua, maka 

laman excel akan menampilkan tabel data. Selanjutkan dilakukan 

pembuatan visualisasi dalam bentuk grafik dengan cara pilihlah menu 

Analyze > PivotChart > Insert Chart (Pilih Bentuk Sajian Grafik) > OK. 
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Gambar 50. Pembuatan PivotChart 

 

Gambar 51. Tampilan Insert Chart 

6. Apabila proses berhasil maka akan terdapat luaran berupa grafik yang 

telah dipilih seperti terlampir pada Gambar 52 sebagai berikut. 

 

Gambar 52. Tampilan Grafik 
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7. Untuk menghilangkan beberapa item yang tidak digunakan pada 

tampilan grafik maka dilakukan dengan cara klik kanan pada tab 

laptop/pc pada bagian value > Hide All Field Buttons on Chart. Maka, 

semua label yang tidak digunakan pada tampilan grafik akan terhapus 

dari tampilan grafik. 

 

Gambar 53. Penghapusan Label pada Grafik 

8. Apabila proses berhasil maka didapatkan hasil tampilan grafik akan 

seperti pada Gambar 54 sebagai berikut. 

 

Gambar 54. Tampilan Grafik Tanpa Label 

9. Agar informasi pada grafik dapat mudah dibaca maknanya, maka 

ditambahkan beberapa elemen dengan meng-klik bagan “+” di samping 

grafik lalu centang beberapa elemen yang diperlukan. 
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Gambar 55. Tampilan Chart Elements 

Informasi terkait tampilan sajian CHART ELEMENTS adalah sebagai 

berikut: 

● Axis: Sumbu 

● Axis Titles: Judul Sumbu 

● Chart Title: Judul Grafik 

● Data Labels: Label Data 

● Data Table: Tabel data di bagian bawah grafik 

● Error Bars: error  

● Gridlines: garis-garis pembatas di bagian belakang grafik 

● Legend: simbol berwarna sebagai pengkategorian 

● Trendline: Garis lurus menaik/menurun 

● Up and Down Bars: batangan yang naik dan turun 

10. Berilah nama pada elemen-elemen informasi terkait grafik mulai dari 

judul grafik hingga label garis yang telah di centang sehingga 

menghasilkan tampilan seperti pada Gambar 56 sebagai berikut. 
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Gambar 56. Tampilan Informasi pada Grafik 

PROSES INSERT SLICER 

11. Buatlah elemen untuk tempat memberikan tampilan menu pilihan pada 

pengguna seperti tombol untuk memilih atau mengklik informasi yang 

diinginkan (misal: memilih informasi wilayah yang diinginkan). Cara 

membuatnya adalah dengan memilih menu Analyze > Insert Slicer > 

Centang Kategori yang dijadikan Filtrasi/Penyaring (Pada Kasus ini 

Wilayah)  

 

Gambar 57. Tampilan Insert Slicer 

 

PROSES PEMBUATAN GRAFIK TOTAL KEMATIAN PER 100.000 

ORANG BERDASARKAN KATEGORI PADA INSERT SLICER 
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12. Apabila ingin menampilkan angka jumlah total pada setiap wilayah 

pada tahun 1990-2019 di bagian laman dashboard, maka buatlah kolom 

baru yang bisa bergerak menyesuaikan pilihan wilayah dengan cara 

scrolling hingga laman Pivot Table terakhir yang menunjukkan nilai 

Grand Total (total kematian per 100.000 orang di satu wilayah dari tahun 

1990-2019) > beri judul indoor, outdoor, dan ozone di samping tabel  

 

Gambar 58. Pembuatan Kategori 

13. Isilah bagian bawah pada setiap judul yaitu indoor, outdoor, dan ozone 

dengan nilai pada Grand Total dengan cara tab entry yang mau 

dimasukkan nilai (di bawah indoor) > tulislah “=” > tab nilai yang mau 

diisi (nilai di samping Grand Total: 93.18) > klik enter pada tab. 
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Gambar 59. Pengisian Nilai 

14. Apabila proses berhasil maka didapat nilai yang sama antara nilai di 

bawah indoor dengan nilai yang di samping Grand Total seperti pada 

Gambar 60 sebagai berikut. 

 

Gambar 60. Tampilan Nilai Terisi 

15. Untuk mengisi nilai di bawah outdoor dan ozone tariklah tanda kecil di 

bagian bawah kotak yang berisi nilai ke samping.
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Gambar 61. Proses Pengisian Nilai Otomatis 

 

Gambar 62. Tampilan Penarikan Pengisian Otomatis 

16. Apabila proses berhasil, maka didapatkan semua entry terisi oleh nilai 

yang sama dengan nilai yang ada di Grand Total seperti pada Gambar 

63 sebagai berikut. 

 

Gambar 63. Tampilan Semua Entry Telah Terisi Nilai 
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PROSES PEMBUATAN GRAFIK 

17. Setelah didapatkan nilai total kematian per 100.000 orang berdasarkan 

wilayah untuk indoor, outdoor, dan ozone, maka selanjutnya adalah 

memvisualisasikannya dalam bentuk tampilan grafik dengan cara blok 

data indoor, outdoor, dan ozone > INSERT > CHARTS > 3D Bar. 

 

Gambar 64. Blok Data 

 

Gambar 65. Pemilihan Tipe Grafik 

18. Apabila proses berhasil maka didapat tampilan luaran seperti pada 

Gambar 66 sebagai berikut. 
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Gambar 66. Proses Pembuatan Grafik 

PROSES PEMBUATAN DESAIN GRAFIK 

19. Untuk memperindah tampilan grafik, maka dilakukan pengeditan 

dengan cara klik grafik > Muncul menu CHART TOOLS  > Design > pilih 

desain yang diinginkan 

 

Gambar 67. Proses Desain Grafik 

20. Agar informasi pada tampilan grafik dapat mudah dibaca dan dipahami, 

maka ditambahkan beberapa elemen grafik dengan meng-klik grafik > 

pilih simbol “+” disamping grafik > centang beberapa elemen grafik 

yang diperlukan. Lengkapilah elemen-elemen informasi terkait grafik 

mulai dari judul grafik hingga label garis. 
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Gambar 68. Tampilan Chart Elements 

 

Gambar 69. Tampilan Grafik 

21. Untuk pembuatan PivotTable dan PivotChart berdasarkan wilayah 

telah selesai, kemudian proses tersebut diulangi untuk pembuatan 

PivotTable dan PivotChart berdasarkan tahunnya yaitu 1990-2019.
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PROSES PIVOT TABLE PADA KASUS PER TAHUN 

22. Pilihlah menu Insert > Pivot Table > Create PivotTable > OK. 

 

Gambar 70. Pembuatan PivotTable 

 

Gambar 71. Tampilan Create Pivot Table 

23. Apabila telah terbuka sheet baru dengan tampilan PivotTable, maka isi 

bagian PivotTable Fields sesuai dengan output yang diinginkan. Pada 

modul pembelajaran ini diisi dengan ketentuan:
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● Choose Fields to add to report (untuk mengisi data yang dipilih untuk 

ditampilkan pada PivotTable): Wilayah, Tahun, Indoor, Outdoor, dan 

Ozone. 

● FILTERS (penyaring): Tahun sebagai bentuk pembagian kelompok 

kategori. 

● COLUMNS (pengisian kolom pada tabel): Nilai jumlahan dari setiap 

kategori tahun. 

●  ROWS (pengisian baris pada tabel): Wilayah yang di isi pada setiap 

baris pada tabel 

● VALUES (pendefinisian nilai-nilai yang akan dimasukkan pada 

bagian COLUMNS): Nilai jumlah indoor, outdoor, dan ozone 

 

Gambar 72. Tampilan PivotTable Fields 

PROSES PIVOT CHART 

24. Apabila setiap elemen pada PivotTable Fields sudah diisi semua, maka 

laman excel akan menampilkan tabel data. Selanjutkan dilakukan 

pembuatan visualisasi dalam bentuk grafik dengan cara pilihlah menu 

Analyze > PivotChart > Insert Chart (Pilih Bentuk Sajian Grafik) > OK 
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Gambar 73. Pemilihan Grafik 

25. Apabila proses berhasil maka akan terdapat luaran berupa grafik yang 

telah dipilih seperti pada Gambar 74 sebagai berikut. 

 

Gambar 74. Tampilan Grafik 

26. Untuk menghilangkan beberapa item yang tidak digunakan pada 

tampilan grafik maka dilakukan dengan cara klik kanan pada tab 

laptop/pc pada bagian value > Hide All Field Buttons on Chart. Maka, 
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semua label yang tidak digunakan pada tampilan grafik akan terhapus 

dari tampilan grafik. 

27.  

Gambar 75. Penghapusan Label pada Grafik 

 

Gambar 76. Tampilan Hide Value Field Buttons on Chart 

28. Apabila proses berhasil maka didapatkan hasil tampilan grafik sesuai 

pada Gambar 77 sebagai berikut. 
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Gambar 77. Tampilan Grafik 

29. Agar informasi pada grafik dapat mudah dibaca maknanya, maka 

ditambahkan beberapa elemen dengan meng-klik bagan “+” di samping 

grafik lalu centang beberapa elemen yang diperlukan. 

 

Gambar 78. Penambahan Elements Chart 
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Gambar 79. Tampilan Chart Elements 

Informasi terkait tampilan sajian CHART ELEMENTS adalah sebagai 

berikut: 

● Axis: Sumbu 

● Axis Titles: Judul Sumbu 

● Chart Title: Judul Grafik 

● Data Labels: Label Data 

● Data Table: Tabel data di bagian bawah grafik 

● Error Bars: error  

● Gridlines: garis-garis pembatas di bagian belakang grafik 

● Legend: simbol berwarna sebagai pengkategorian 

● Trendline: Garis lurus menaik/menurun 

● Up and Down Bars: batangan yang naik dan turun 
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30. Berilah nama pada elemen-elemen informasi terkait grafik mulai dari 

judul grafik hingga label garis yang telah di ceklis sehingga 

menghasilkan tampilan seperti pada Gambar 80 sebagai berikut. 

 

Gambar 80. Tampilan Grafik Akhir 

PROSES INSERT SLICER 

31. Buatlah elemen untuk tempat memberikan tampilan menu pilihan pada 

pengguna seperti tombol untuk memilih atau mengklik informasi yang 

diinginkan (misal: memilih informasi tahun yang diinginkan). Cara 

membuatnya adalah dengan memilih menu Analyze > Insert Slicer > 

Centang Kategori yang dijadikan Filtrasi/Penyaring (Pada Kasus ini 

Tahun)  

 

Gambar 81. Proses Insert Slicer 
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Gambar 82. Pemilihan Kategori Insert Slicer 

32. Apabila proses berhasil maka akan didapat hasil seperti pada Gambar 83 

sebagai berikut. 

 

Gambar 83. Tampilan Slicer Berdasarkan Tahun 

PROSES PEMBUATAN GRAFIK TOTAL KEMATIAN PER 100.000 

ORANG BERDASARKAN KATEGORI PADA INSERT SLICER 

33. Apabila ingin menampilkan angka jumlah total pada setiap tahun pada 

wilayah-wilayah di Asia di bagian laman dashboard, maka buatlah 

kolom baru yang bisa bergerak menyesuaikan pilihan wilayah dengan 

cara scrolling hingga laman Pivot Table terakhir yang menunjukkan nilai 

Grand Total (total kematian per 100.000 orang di wilayah Asia per tahun 
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dari 1990-2019) > beri judul indoor, outdoor, dan ozone di samping 

tabel. 

 

Gambar 84. Pembuatan Kategori 

34. Isilah bagian bawah pada setiap judul yaitu indoor, outdoor, dan ozone 

dengan nilai pada Grand Total dengan cara tab entry yang mau 

dimasukkan nilai (di bawah indoor) > tulislah “=” > tab nilai yang mau 

diisi (nilai di samping Grand Total: 93.18) > klik enter pada tab. 

 

Gambar 85. Pengisian Nilai pada Setiap Kategori 

35. Untuk mengisi nilai di bawah outdoor dan ozone tariklah tanda kecil di 

bagian bawah kotak yang berisi nilai ke samping. 



52  

 

Gambar 86. Pengisian Nilai Otomatis 

 

Gambar 87. Penarikan Blok 

36. Apabila proses berhasil, maka didapatkan semua entry terisi oleh nilai 

yang sama dengan nilai yang ada di Grand Total seperti pada Gambar 

88 sebagai berikut. 

 

Gambar 88. Tampilan Semua Entry Terisi Nilai 
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PROSES PEMBUATAN GRAFIK 

37. Setelah didapatkan nilai total kematian per 100.000 orang berdasarkan 

wilayah untuk indoor, outdoor, dan ozone, maka selanjutnya adalah 

memvisualisasikannya dalam bentuk tampilan grafik dengan cara blok 

data indoor, outdoor, dan ozone > INSERT > CHARTS > 3D Bar. 

 

Gambar 89. Blok Data 

 

Gambar 90. Tampilan Desain Grafik 

PROSES PEMBUATAN DESAIN GRAFIK 

38. Agar informasi pada tampilan grafik dapat mudah dibaca dan dipahami, 

maka ditambahkan beberapa elemen grafik dengan meng-klik grafik > 

pilih simbol “+” disamping grafik > centang beberapa elemen grafik 
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yang diperlukan. Lengkapilah elemen-elemen informasi terkait grafik 

mulai dari judul grafik hingga label garis. 

 

Gambar 91. Penambahan Elements Chart 

 

Gambar 92. Penambahan Judul Grafik 
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Gambar 93. Tampilan Grafik yang Memiliki Informasi 

39. Untuk memperindah tampilan grafik, maka dilakukan pengeditan 

dengan cara klik grafik > Muncul menu CHART TOOLS > Design > pilih 

desain yang diinginkan. 

 

Gambar 94. Tampilan Hasil Akhir Grafik 

PROSES PEMBUATAN DESAIN DASHBOARD 

PEMBUATAN LAMAN DASHBOARD 

40. Apabila telah selesai melakukan proses pembuatan elemen-elemen yang 

akan ditampilkan pada dashboard seperti grafik maupun nilai angka, 

maka selanjutnya akan melakukan proses pembuatan desain dashboard. 
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Prosesnya bisa dimulai dengan membuka halaman baru pada sheet excel 

dengan meng-klik tombol panah di bagian bawah Microsoft excel. 

 

Gambar 95. Penambahan sheet baru 

 

Gambar 96. Tampilan Laman Sheet Baru 

41. Berikanlah nama laman sheet dengan nama DASHBOARD dengan cara 

klik kanan pada tab > Rename > beri nama DASHBOARD. 
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Gambar 97. Pergantian Nama Sheet 

 

Gambar 98.  Laman Dashboard 

DESAIN WARNA BACKGROUND DASHBOARD 

42. Warnailah background laman excel dashboard dengan cara tab ujung 

laman excel > HOME > Fill Color (pilih warna yang diinginkan) 
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Gambar 99. Pewarnaan Background Halaman Dashboard 

 

Gambar 100. Tampilan Theme Colors 

43. Apabila menginginkan pilihan warna yang lebih banyak maka pilih 

menu more colors > colors (standard atau custom) > OK. 
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Gambar 101. Informasi Tambahan Warna 

 

Gambar 102. Tampilan Colors: Standard 

 

Gambar 103. Tampilan Colors: Custom 
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44. Apabila proses berhasil maka didapatkan hasil pada Gambar 104 sebagai 

berikut. 

 

Gambar 104. Tampilan Warna Background Laman 

PEMBUATAN HEADER (JUDUL) DASHBOARD 

45. Pilihlah baris dan kolom pertama pada halaman excel, kemudian tulislah 

judul “Kematian Akibat Polusi Udara Per -100.000 Orang di Benua Asia”. 

 

Gambar 105. Penulisan Judul Dashboard 
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Gambar 106. Tampilan Judul Dashboard 

46. Agar judul terlihat, maka blok 3 baris hingga ke kolom W (Sesuai 

Keinginan) pada laman excel > HOME > Merge & Center. 

 

Gambar 107. Proses Merge & Center 

47. Selanjutnya maka akan dihasilkan posisi tulisan berada di tengah-tengah 

laman dashboard, kemudian Agar memperindah tampilan maka 

dilakukan pengeditan pada tampilan judul dashboard. 
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Gambar 108. Tampilan Judul Dashboard 

 

Gambar 109. Menu Pengeditan Tulisan 

 

Gambar 110. Menu Pengeditan Warna Teks 
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Gambar 111. Menu Pengeditan Warna Background Tulisan 

 

Gambar 112. Hasil Tampilan Akhir Judul Dashboard 

48. Copy-lah elemen Insert Slicer berupa tahun dan wilayah yang telah dibuat 

sebelumnya dan paste pada halaman dashboard dengan cara klik 

elemen insert slicer > klik kanan pada tab atau “Ctrl+C” > buka sheet 

laman dashboard > paste atau “Ctrl+V”. 
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Gambar 113. Proses Copy Slicer Per-Wilayah 

 

Gambar 114. Menu Paste Pada Laman Dashboard 

 

Gambar 115. Tampilan Slicer Wilayah di Laman Dashboard 
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Gambar 116. Proses Copy Slicer Per-Tahun 

 

Gambar 117. Tampilan Slicer Tahun di Laman Dashboard 

49. Edith tampilan elemen insert slicer dengan cara klik OPTIONS > Slicer 

Styles > Pilih desain yang diinginkan. Apabila ingin mengedit desain 

yang didesain sendiri maka bisa dengan cara klik new slicer style > 

Format > desain elemen > OK.  
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Gambar 118. Proses Pengeditan Warna Desain Slicer 

 

Gambar 119. Tampilan New Slicer Style 

Isi dari Format Slicer Element: 

- Font: berisi informasi terkait desain tulisan mulai dari tampilan tulisan, 

ukuran, dan warna tulisan 
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Gambar 120. Proses Edit Teks Slicer 

- Border: berisi informasi terkait desain garis luar pada tampilan tabel 

slicer 

 

Gambar 121. Proses Edit Border Slicer 

- Fill: berisi informasi terkait desain warna pada tampilan tabel slicer 
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Gambar 122. Proses Edit Fill Slicer 

 

 

Gambar 123. Proses Edit Fill Slicer: Fill Effect 

 

Gambar 124. Proses Edit Fill Slicer: More Colors 
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Gambar 125.  Menu More Colors pada Fill Color: Standard dan Custom 

 

Gambar 126. Menu New Styles 

50. Apabila desain yang telah dibuat selesai, maka akan muncul pada bagian 

slicer styles, kemudian klik elemen slicer > pilih desain yang telah 

dibuat. 
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Gambar 127. Menu Slicer Styles 

 

Gambar 128. Tampilan Hasil Akhir Slicer 

51. Buatlah suatu bagan tempat suatu nilai yang berubah sesuai dengan 

pilihan slicer. Pada kasus di modul ini merupakan total kematian per 

100.000 orang akibat polusi udara dengan 3 kategori berupa indoor, 

outdoor, dan ozone berdasarkan wilayah. Cara yang digunakan adalah 
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pilih menu INSERT > Illustrations > Shapes > Pilih bentuk yang 

diinginkan. 

 

Gambar 129. Proses Membuat Shape 

 

Gambar 130. Tampilan Shape 

Klik bentuk/bagan yang telah dipilih > Text Box (Untuk menuliskan 

tulisan di dalam bentuk/bagan) 

 

Gambar 131. Text Box 
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52. Tulislah kalimat yang menjadi judul informasi (pada kasus ini terdapat 

3 kategori yaitu Indoor, outdoor, ozone). 

 

Gambar 132. Penulisan Judul Nilai Data 

53. Editlah tampilan dari bagan yang telah dibuat dengan memilih menu 

FORMAT . 

 

Gambar 133. Desain Shape 
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Gambar 134. Menu Edit Warna Teks 

 

Gambar 135. Menu Desain Shape 

 

Gambar 136. Menu Efek Shape 
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54. Apabila ingin mengedit jenis tulisan, ukuran hingga tata letak tulisan 

maka klik bagan > HOME > Font (jenis, warna dan ukuran tulisan) > 

Alignment (Tata letak tulisan) 

 

Gambar 137. Menu Edit Tulisan Shape 

 

Gambar 138. Menu Ukuran Tulisan 

Apabila proses berhasil maka didapatkan hasil seperti pada Gambar 138 

sebagai berikut. 
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Gambar 139. Tampilan Akhir Shape Untuk Kategori Nilai 

55. Kemudian, buatlah bagan untuk meletakkan nilai (angka) yang dapat 

berubah sesuai dengan slicer yang dipilih dengan cara pilih menu 

INSERT > Shapes > Pilih bentuk > Copy (Ctrl + C) & paste (Ctrl + V) 

menjadi tiga 

 

Gambar 140. Proses Membuat Shape Untuk Nilai 
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Gambar 141. Output Tampilan Shape 

 

Gambar 142. Bentuk Untuk Meletakkan Nilai 

56. Editlah bagan dengan cara klik bagan > FORMAT > Pilih desain. 

 

Gambar 143. Pemilihan Desain Shape 
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Gambar 144. Desain Efek Shape 

 

Gambar 145. Hasil Desain Shape Nilai 

57. Selanjutnya dilakukan pengisian nilai dengan cara klik bagan > tulislah 

“=” > klik nilai yang diinginkan > Enter. 
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Gambar 146. Proses Input Nilai ke Dalam Shape 

 

Gambar 147. Proses Input Nilai Ke Dalam Shape 

58. Lakukan hal yang sama pada kategori outdoor seperti pada Gambar 148 

sebagai berikut. 

Klik 

 Klik 
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Gambar 148. Proses Yang Sama Pada Kategori Outdoor 

 

Gambar 149. Hasil Nilai Pada Shape Dashboard 

59. Lakukan hal yang sama pada menu ozone seperti pada ilustrasi Gambar 

150 sebagai berikut. 
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Gambar 150. Proses yang Sama Pada Kategori Ozone 

60. Editlah bentuk tampilan pada bagan dengan cara memilih menu HOME 

>  Font (jenis, warna dan ukuran tulisan) > Alignment (Tata letak 

tulisan)

 

Gambar 151. Menu Edit Font pada Shape 
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61. Maka didapatkan bentuk tampilan akhir seperti pada Gambar 152 

sebagai berikut.  

 

Gambar 152. Tampilan Hasil Akhir Nilai 

Elemen-elemen pada desain FORMAT SHAPE: 

- Shape Fill: Menu untuk pengeditan warna dasar bentuk bagan 

 

Gambar 153. Menu Shape Fill 

- Shape Outline: Menu untuk pengeditan warna garis luar/pembentuk 

bagan 
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Gambar 154. Menu Shape Outline 

- Shape Effect:  Menu pengeditan untuk tampilan efek pada bagan 

 

Gambar 155. Menu Shape Effect 

- Text Fill: Menu untuk pengeditan warna dasar tulisan di dalam shape 

 

Gambar 156. Menu Text Fill 
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Text Outline: Menu untuk pengeditan warna garis luar/pembentuk 

tulisan yang ada di dalam shape 

 

Gambar 157. Menu Text Outline 

- Text Effect: Menu pengeditan untuk tampilan efek pada tulisan di 

dalam shape 

 

Gambar 158. Menu Text Effect 

Copy (Ctrl + C) dan paste (Ctrl + V) setiap grafik yang telah di buat ke 

dalam laman dashboard 



84  

 

Gambar 159. Copy & Paste Grafik Per-Wilayah pada Laman Dashboard 

 

Gambar 160. Copy & Paste Grafik Per-Tahun pada Laman Dashboard 

 

Gambar 161. Peletakkan Grafik Pada Halaman Dashboard 

62. Editlah grafik dengan menggunakan menu DESIGN > Pilih Style (style 

grafik) > Change Colour (warna grafik)  
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Gambar 162. Menu Desain Chart 

 
Gambar 163. Menu Merubah Desain Warna 

Untuk melakukan pengeditan warna dasar grafik maka klik kanan tab 

pada grafik > Format Chart Area > Chart Options. 
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Gambar 164. Menu Format Chart Area 

 

Gambar 165. Langkah Merubah Warna Area Chart 
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Gambar 166. Menu Merubah style dan warna garis luaran pada bagan 

grafik 

Menu Fill bertujuan untuk mengisi warna pada background grafik, 

adapun elemennya sebagai berikut: 

● No fill (tidak berwarna) 

● Solid fill (pilihan warna solid) 

● Gradient fill (pilihan warna gradasi/campuran) 

● Picture of texture fill (pilihan gambar bawaan dari Microsoft) 

● Pattern fill (pilihan pola bawaan dari Microsoft) 

● Automatic (kembali ke warna background bawaan yang dipilih pada 

menu design) 

Menu Border bertujuan untuk mengisi warna pada garis luaran 

(berbentuk kotak) pada grafik, adapun elemennya sebagai berikut: 

● No line (tidak bergaris) 

● Solid line (pilihan warna solid) 

● Gradient line (pilihan warna gradasi/campuran) 

● Automatic (kembali ke warna background bawaan yang dipilih pada 

menu design) 
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63. Apabila ingin menebalkan garis luar bagan grafik maka pilih menu 

FORMAT > Shape Outline > Weight > pilih ukuran ketebalan garis. 

 

Gambar 167. Petunjuk Memilih Ketebalan Garis Bingkai Grafik 

64. Lakukan hal yang sama pada setiap grafik yang telah dibuat, kemudian 

maka akan dihasilkan bentuk dashboard sederhana seperti pada Gambar 

168 sebagai berikut. 

 

Gambar 168. Hasil Dashboard Sederhana 
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2.4. Cara Menambahkan dan Mengedit Database 

Pembahasan selanjutnya berkaitan dengan proses penambahan 

database pada dashboard. Penambahan data tentunya sering terjadi seiring 

bertambahnya waktu, apalagi berkaitan dengan kasus data yang harus 

realtime. Oleh karena itu, penambahan database cukup penting dilakukan. 

Adapun langkah-langkahnya adalah sebagai berikut. 

1. Masih dengan data yang sama dengan tahapan pembuatan dashboard 

sebelumnya, maka pada langkah pertama bukalah database dashboard. 

 

Gambar 169. Tampilan Database 

2. Tambahkan data baru pada laman database dashboard, boleh dituliskan 

langsung pada laman maupun copy paste dari tempat lain. 

 

Gambar 170. Tempat Mengisi Database 
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Gambar 171. Tampilan Data Terbaru 

3. Silakan masuk ke laman PIVOTTABLE > Klik tabel Pivot > ANALYZE > 

Change Data Source > Move PivotTable > Table/Range (Blok database 

sampai data yang baru dimasukkan) > OK. 

 

Gambar 172. Menu Change Data Source 
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Gambar 173. Menu Move PivotTable 

4. Selanjutnya, kembalilah ke lama PivotTable Klik Tabel Pivot > ANALYZE 

> Refresh. 

 

Gambar 174.  Menu Refresh 

Apabila ingin melakukan pengeditan dengan cara merubah isi 

pada database yang telah tersedia, maka langsung masuk ke laman 

DATABASE dashboard dan langsung ganti saja data tersebut. Kemudian 
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masuk ke laman PivotTable dan klik Refresh. Maka tampilan dashboard 

akan mengikuti data yang telah diperbarui. 

2.5. Memanfaatkan Google Sheets Untuk Dashboard Excel 

Apabila ingin memanfaatkan tampilan secara online dan bisa di akses 

oleh semua orang maupun orang-orang tertentu, maka dapat 

memanfaatkan Google Sheet sebagai opsi dari pembuatan dashboard. 

Disarankan untuk melakukan pembuatan desain di dalam Google Sheet 

secara langsung. Meskipun dapat meng-upload file dari Microsoft Excel 

secara langsung, namun ada kemungkinan tampilan berantakan ataupun 

beberapa elemen tidak dapat dilihat. Sehingga informasi yang ingin 

disampaikan tidak tersampaikan. Adapun langkah-langkah pembagian 

dashboard melalui Google Sheet adalah sebagai berikut. 

1. Buka Google Sheet 

• Klik ikon “+” 

• Desain tampilan dashboard pada laman spreadsheet. 

• Apabila ingin meng-upload dari Microsoft Excel, maka Cntrl + O > 

Upload > Jelajah > Pilih file yang diinginkan. 

2. Berilah nama spreadsheet dan simpan ke Google Drive. 

3. Bagikan File: 

• Pilih file yang sudah dikonversi di Google Drive. 

• Klik kanan dan pilih "Share" atau klik tombol "Share" di bagian atas. 

4. Atur Pengaturan Berbagi: 

• Masukkan alamat email atau buat tautan berbagi. 

• Pilih izin akses, seperti "Can edit" (bisa mengedit) atau "Can view" (hanya 

bisa melihat). 
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SOAL DAN LATIHAN 

1. Sebutkan komponen pembuatan dashboard berbasis excel sederhana! 

2. Buatlah database di bawah ini dalam bentuk dashboard interaktif yang 

sederhana dan ikutilah petunjuk pembuatan yang telah dibuatkan 

sebelumnya! 

Data ini berisi data yang dipraktikkan ke dalam modul pembelajaran ini, 

namun untuk data hanya berisi 5 wilayah dari tahun 1990-2019. 

Wilayah Kode Tahun Indoor Outdoor Ozone 

Afghanistan AFG 1990 370.0504743 30.82269327 6.581093018 

Afghanistan AFG 1991 358.9784184 29.82618393 6.267612665 

Afghanistan AFG 1992 352.7664528 29.20203007 5.926444093 

Afghanistan AFG 1993 357.0559225 29.42970167 5.860345034 

Afghanistan AFG 1994 362.9704392 29.81325866 6.065342753 

Afghanistan AFG 1995 363.2329649 29.78790058 6.271907286 

Afghanistan AFG 1996 364.6081627 29.84173921 6.226651218 

Afghanistan AFG 1997 367.3937773 29.981738 6.281136382 

Afghanistan AFG 1998 369.8136956 30.1054353 6.44358683 

Afghanistan AFG 1999 372.2469924 30.25074644 6.843479969 

Afghanistan AFG 2000 371.9513445 30.2521756 6.974857743 

Afghanistan AFG 2001 368.4902535 30.16678976 6.594309296 

Afghanistan AFG 2002 355.8708514 29.55401111 6.134489856 

Afghanistan AFG 2003 350.1887476 29.67531712 6.312662648 

Afghanistan AFG 2004 341.8581056 29.73235031 6.218759979 

Afghanistan AFG 2005 331.0811191 29.65839479 6.111156509 

Afghanistan AFG 2006 320.2875784 30.27334722 5.805519069 

Afghanistan AFG 2007 306.5021038 31.67028401 6.56831134 

Afghanistan AFG 2008 292.5475289 33.66889197 6.826563086 

Afghanistan AFG 2009 278.2761753 35.86002732 6.25218652 

Afghanistan AFG 2010 265.0947492 38.09073653 5.457025835 

Afghanistan AFG 2011 252.4725103 41.25617207 5.11224959 

Afghanistan AFG 2012 239.7294396 45.56430469 5.201869274 

Afghanistan AFG 2013 227.3272139 49.77596117 5.267735892 
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Afghanistan AFG 2014 216.5716077 52.99404901 4.926678553 

Afghanistan AFG 2015 208.0648033 54.27253393 5.145500768 

Afghanistan AFG 2016 200.6279496 53.67419963 5.435587081 

Afghanistan AFG 2017 194.3335609 53.32235623 5.790926921 

Afghanistan AFG 2018 187.2769889 54.43239826 5.112804737 

Afghanistan AFG 2019 179.4553489 56.89574057 5.04938666 

Armenia ARM 1990 38.4886483 87.40572185 4.188172642 

Armenia ARM 1991 39.99930077 91.07635246 4.068156964 

Armenia ARM 1992 43.8772353 99.96683057 4.115819482 

Armenia ARM 1993 45.58187463 104.4722167 4.170547922 

Armenia ARM 1994 43.02579458 99.53453184 4.054758469 

Armenia ARM 1995 41.95732947 97.60676587 4.071128473 

Armenia ARM 1996 41.2251998 97.26557412 3.783235646 

Armenia ARM 1997 38.26007291 92.51766031 3.359195721 

Armenia ARM 1998 36.27169149 90.64288041 3.172155641 

Armenia ARM 1999 34.58012146 90.67409139 3.31816795 

Armenia ARM 2000 32.02569011 88.53085688 3.304892589 

Armenia ARM 2001 29.77902486 89.28848264 3.001566916 

Armenia ARM 2002 26.61970843 90.50939676 3.036210671 

Armenia ARM 2003 23.34531373 92.77778474 3.055782898 

Armenia ARM 2004 19.52056269 92.64648366 3.0927427 

Armenia ARM 2005 16.46996002 93.23982764 3.124716247 

Armenia ARM 2006 13.86614784 94.17622442 3.346972393 

Armenia ARM 2007 11.05666236 92.85888145 3.720683416 

Armenia ARM 2008 8.884817516 94.30431136 3.776936877 

Armenia ARM 2009 7.003425898 94.06442371 3.612328586 

Armenia ARM 2010 5.693845414 92.87310705 3.312624226 

Armenia ARM 2011 4.813795624 91.3980194 3.525530393 

Armenia ARM 2012 4.073933102 89.11163165 3.625891985 

Armenia ARM 2013 3.453858104 86.18906039 3.718810014 

Armenia ARM 2014 3.045150934 85.68966579 3.668701946 

Armenia ARM 2015 2.768275135 86.02474928 3.697104562 

Armenia ARM 2016 2.500117566 82.59886897 3.777964438 

Armenia ARM 2017 2.318998887 80.11599584 3.774980821 

Armenia ARM 2018 2.144810889 78.76234262 3.838953667 
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Armenia ARM 2019 1.978052438 77.52240966 3.885792616 

Azerbaijan AZE 1990 75.86461937 69.1196137 2.476822632 

Azerbaijan AZE 1991 77.43062133 74.20216768 2.523620926 

Azerbaijan AZE 1992 80.56841899 81.21179585 2.597349644 

Azerbaijan AZE 1993 83.09777998 87.6920255 2.735953683 

Azerbaijan AZE 1994 84.83347171 93.26732592 2.947433038 

Azerbaijan AZE 1995 82.30267691 93.94433095 2.965317066 

Azerbaijan AZE 1996 78.43683638 92.73588282 2.668227648 

Azerbaijan AZE 1997 73.93092019 90.93119141 2.442315402 

Azerbaijan AZE 1998 70.05580099 90.1818295 2.274877562 

Azerbaijan AZE 1999 66.12000721 89.84708815 2.214616881 

Azerbaijan AZE 2000 61.95577953 89.56747512 2.023483345 

Azerbaijan AZE 2001 56.75402615 88.35965101 1.6999426 

Azerbaijan AZE 2002 52.97898264 90.28039661 1.63199033 

Azerbaijan AZE 2003 49.49944844 93.46009448 1.586473878 

Azerbaijan AZE 2004 44.94283827 95.2044705 1.571392418 

Azerbaijan AZE 2005 41.41383942 99.20793705 1.456077752 

Azerbaijan AZE 2006 36.81456011 102.3206885 1.516837557 

Azerbaijan AZE 2007 31.41703447 105.1552727 1.615400656 

Azerbaijan AZE 2008 26.39419465 108.7140889 1.782104375 

Azerbaijan AZE 2009 22.21299416 111.7054318 1.731784285 

Azerbaijan AZE 2010 19.38689323 113.9576698 1.588107405 

Azerbaijan AZE 2011 17.5702147 115.6062047 1.756998556 

Azerbaijan AZE 2012 16.10053865 117.3394177 1.910957204 

Azerbaijan AZE 2013 14.88528969 118.320373 2.10291511 

Azerbaijan AZE 2014 14.00364564 120.1936784 2.171292621 

Azerbaijan AZE 2015 12.98250953 119.7261065 2.222693887 

Azerbaijan AZE 2016 12.16103108 117.9562214 2.433635407 

Azerbaijan AZE 2017 11.43833421 116.030723 2.41745656 

Azerbaijan AZE 2018 10.23231885 110.1867443 2.370075855 

Azerbaijan AZE 2019 9.38676446 108.3913639 2.373313785 

Bahrain BHR 1990 17.79624304 195.6431501 7.818034805 
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Bahrain BHR 1991 16.12467186 196.1310949 7.742741063 

Bahrain BHR 1992 14.26990521 192.3833752 7.654358972 

Bahrain BHR 1993 12.23752052 183.985313 7.133804428 

Bahrain BHR 1994 10.5960694 179.7090906 7.395995786 

Bahrain BHR 1995 9.360793016 179.6560424 7.682478561 

Bahrain BHR 1996 8.368776521 181.6934805 7.932505815 

Bahrain BHR 1997 7.240356976 180.6605205 7.928475117 

Bahrain BHR 1998 6.300456372 181.407793 8.376246856 

Bahrain BHR 1999 5.479361917 180.9076024 8.839469642 

Bahrain BHR 2000 4.169380567 158.6891165 7.723684928 

Bahrain BHR 2001 3.111492313 137.4975852 6.248810937 

Bahrain BHR 2002 2.997133592 157.0446332 7.055935829 

Bahrain BHR 2003 2.800561836 174.8860695 8.659341544 

Bahrain BHR 2004 2.394375673 175.8176561 8.428142144 

Bahrain BHR 2005 2.049426898 173.2900753 8.275753045 

Bahrain BHR 2006 1.742266234 166.2144208 7.836146703 

Bahrain BHR 2007 1.480083475 158.1533347 8.694572838 

Bahrain BHR 2008 1.266589336 150.7612467 8.619920148 

Bahrain BHR 2009 1.082473635 143.0553721 7.149264049 

Bahrain BHR 2010 0.939402798 137.5304293 5.911121568 

Bahrain BHR 2011 0.823611428 133.4609308 5.353102465 

Bahrain BHR 2012 0.726146263 130.4166784 5.566109272 

Bahrain BHR 2013 0.616224601 121.6142635 5.142942453 

Bahrain BHR 2014 0.521820161 113.0478905 4.592882643 

Bahrain BHR 2015 0.458084896 109.0957052 4.737764166 

Bahrain BHR 2016 0.421743974 108.0100004 5.032903225 

Bahrain BHR 2017 0.389640523 107.5541919 5.302118757 

Bahrain BHR 2018 0.338620075 104.8588523 4.999619058 

Bahrain BHR 2019 0.288910768 103.7141549 5.041756701 

Bangladesh BGD 1990 249.2863531 32.39063287 9.568393213 

Bangladesh BGD 1991 228.0474606 31.19677342 9.166396313 

Bangladesh BGD 1992 223.2266143 32.17982961 9.25258005 
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Bangladesh BGD 1993 216.2595088 33.00604939 9.927137222 

Bangladesh BGD 1994 209.6263095 33.84895135 9.85850298 

Bangladesh BGD 1995 207.4792128 35.45937936 10.33755728 

Bangladesh BGD 1996 199.8215755 36.39726556 10.28250887 

Bangladesh BGD 1997 191.9842169 37.46194394 10.51892895 

Bangladesh BGD 1998 188.4524119 39.1443416 10.64156574 

Bangladesh BGD 1999 186.932235 40.94936567 10.92292862 

Bangladesh BGD 2000 187.4407337 42.91470834 10.54905174 

Bangladesh BGD 2001 184.9947175 43.59975734 10.05878644 

Bangladesh BGD 2002 187.4003856 45.21408169 9.845892629 

Bangladesh BGD 2003 188.7097043 46.64179274 10.60674787 

Bangladesh BGD 2004 185.894679 47.0810871 10.53532246 

Bangladesh BGD 2005 184.7686673 48.26875853 10.55172956 

Bangladesh BGD 2006 183.3389219 50.15403506 10.5442524 

Bangladesh BGD 2007 175.6585909 50.99142112 10.9970226 

Bangladesh BGD 2008 164.4144123 50.92487943 10.60149535 

Bangladesh BGD 2009 155.5293414 51.66753005 9.47731675 

Bangladesh BGD 2010 148.7224012 53.24995868 9.561182394 

Bangladesh BGD 2011 129.5768156 51.01402427 9.005134558 

Bangladesh BGD 2012 112.9534819 50.25644101 8.654390582 

Bangladesh BGD 2013 104.6160924 53.07292528 8.382205025 

Bangladesh BGD 2014 100.3938196 57.10255536 8.214684733 

Bangladesh BGD 2015 93.38283069 56.93632672 7.710435219 

Bangladesh BGD 2016 89.5049878 56.46014294 7.84281458 

Bangladesh BGD 2017 89.29571092 58.56810401 8.365181584 

Bangladesh BGD 2018 84.67409591 59.57005939 8.770039648 

Bangladesh BGD 2019 79.25479103 61.78096654 8.848887349 

3. Informasi apakah yang dapat ditampilkan berdasarkan database di atas 

dalam bentuk tampilan dashboard interaktif? 

4. Cobalah Membuat dashboard interaktif dengan database di bawah ini 

sekreatif mungkin dan berikan informasi apa saja yang bisa di 

tampilkan! 
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Wilayah Kode Tahun 
< 5 

Tahun 

5 - 14 

Tahun 

15 - 49 

Tahun 

50 - 69 

Tahun 

> 70 

Tahun 
Kategori 

Afghanistan AFG 1990 0.14388 0.00288 0.02584 0.09491 0.07621 Indoor 

Afghanistan AFG 1991 0.15136 0.00311 0.02664 0.09572 0.07708 Indoor 

Afghanistan AFG 1992 0.17305 0.00356 0.02846 0.09732 0.07826 Indoor 

Afghanistan AFG 1993 0.19747 0.00391 0.03024 0.09979 0.08013 Indoor 

Afghanistan AFG 1994 0.21116 0.00405 0.03158 0.10247 0.08227 Indoor 

Afghanistan AFG 1995 0.21577 0.00419 0.03236 0.104 0.08392 Indoor 

Afghanistan AFG 1996 0.22047 0.00445 0.03388 0.10549 0.08576 Indoor 

Afghanistan AFG 1997 0.22519 0.00484 0.03547 0.10695 0.08772 Indoor 

Afghanistan AFG 1998 0.22129 0.005 0.03648 0.10819 0.08959 Indoor 

Afghanistan AFG 1999 0.21359 0.00506 0.03721 0.10957 0.09138 Indoor 

Afghanistan AFG 2000 0.20541 0.00511 0.03906 0.10901 0.09273 Indoor 

Afghanistan AFG 2001 0.20127 0.0053 0.0404 0.1098 0.0935 Indoor 

Afghanistan AFG 2002 0.19542 0.0054 0.0407 0.10707 0.09277 Indoor 

Afghanistan AFG 2003 0.20426 0.00652 0.04196 0.10482 0.09198 Indoor 

Afghanistan AFG 2004 0.20124 0.0068 0.04357 0.10245 0.09127 Indoor 

Afghanistan AFG 2005 0.19215 0.00665 0.04488 0.0986 0.09052 Indoor 

Afghanistan AFG 2006 0.18082 0.00632 0.04616 0.09494 0.08954 Indoor 

Afghanistan AFG 2007 0.16819 0.00596 0.04748 0.09081 0.08803 Indoor 

Afghanistan AFG 2008 0.15548 0.00543 0.04906 0.08693 0.08629 Indoor 

Afghanistan AFG 2009 0.14471 0.005 0.05004 0.08283 0.08417 Indoor 

Afghanistan AFG 2010 0.13841 0.00485 0.05115 0.07845 0.08225 Indoor 

Afghanistan AFG 2011 0.13127 0.00455 0.05217 0.07556 0.08025 Indoor 

Afghanistan AFG 2012 0.12419 0.00424 0.05263 0.07322 0.07796 Indoor 

Afghanistan AFG 2013 0.12047 0.00421 0.05236 0.07091 0.07548 Indoor 

Afghanistan AFG 2014 0.11419 0.00395 0.05196 0.06928 0.07357 Indoor 

Afghanistan AFG 2015 0.10753 0.00371 0.05216 0.0685 0.07216 Indoor 

Afghanistan AFG 2016 0.10309 0.00359 0.05225 0.06941 0.07095 Indoor 

Afghanistan AFG 2017 0.09776 0.00342 0.05233 0.07147 0.07001 Indoor 

Afghanistan AFG 2018 0.09168 0.00316 0.05133 0.0735 0.06851 Indoor 

Afghanistan AFG 2019 0.08735 0.00302 0.04961 0.07514 0.06656 Indoor 

Azerbaijan AZE 1990 0.01179 0.00029 0.00272 0.0138 0.0128 Indoor 

Azerbaijan AZE 1991 0.01133 0.00032 0.00294 0.01472 0.01306 Indoor 

Azerbaijan AZE 1992 0.01074 0.00034 0.0034 0.01586 0.0134 Indoor 

Azerbaijan AZE 1993 0.01003 0.00036 0.00358 0.01659 0.01398 Indoor 

Azerbaijan AZE 1994 0.0093 0.00039 0.00387 0.01681 0.01438 Indoor 

Azerbaijan AZE 1995 0.00852 0.00041 0.00378 0.01655 0.01368 Indoor 

Azerbaijan AZE 1996 0.00777 0.00039 0.00372 0.01602 0.01301 Indoor 

Azerbaijan AZE 1997 0.00703 0.00038 0.00351 0.01503 0.0125 Indoor 

Azerbaijan AZE 1998 0.00636 0.00037 0.00331 0.01421 0.01224 Indoor 

Azerbaijan AZE 1999 0.00566 0.00035 0.00313 0.01317 0.01231 Indoor 
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Azerbaijan AZE 2000 0.00494 0.00034 0.00299 0.01212 0.01214 Indoor 

Azerbaijan AZE 2001 0.00422 0.0003 0.00279 0.01102 0.01191 Indoor 

Azerbaijan AZE 2002 0.00371 0.00025 0.00264 0.01023 0.01157 Indoor 

Azerbaijan AZE 2003 0.00331 0.0002 0.00254 0.00935 0.0114 Indoor 

Azerbaijan AZE 2004 0.00292 0.00016 0.00241 0.00838 0.01076 Indoor 

Azerbaijan AZE 2005 0.00254 0.00013 0.00227 0.00759 0.01038 Indoor 

Azerbaijan AZE 2006 0.00218 0.00009 0.00199 0.0066 0.00978 Indoor 

Azerbaijan AZE 2007 0.00179 0.00007 0.00169 0.00553 0.00882 Indoor 

Azerbaijan AZE 2008 0.00147 0.00005 0.00144 0.00467 0.00778 Indoor 

Azerbaijan AZE 2009 0.00121 0.00004 0.00121 0.00391 0.00688 Indoor 

Azerbaijan AZE 2010 0.00104 0.00003 0.00104 0.00345 0.00618 Indoor 

Azerbaijan AZE 2011 0.00091 0.00003 0.00094 0.0032 0.00574 Indoor 

Azerbaijan AZE 2012 0.0008 0.00002 0.00085 0.00305 0.00531 Indoor 

Azerbaijan AZE 2013 0.0007 0.00002 0.00075 0.00295 0.00495 Indoor 

Azerbaijan AZE 2014 0.00062 0.00002 0.00066 0.00294 0.0046 Indoor 

Azerbaijan AZE 2015 0.00055 0.00002 0.00059 0.00297 0.00415 Indoor 

Azerbaijan AZE 2016 0.00048 0.00002 0.00053 0.003 0.00386 Indoor 

Azerbaijan AZE 2017 0.00042 0.00002 0.0005 0.00301 0.00362 Indoor 

Azerbaijan AZE 2018 0.00037 0.00001 0.00049 0.00292 0.00323 Indoor 

Azerbaijan AZE 2019 0.00033 0.00001 0.00046 0.00287 0.00299 Indoor 

Bangladesh BGD 1990 0.80898 0.0232 0.10749 0.34422 0.398 Indoor 

Bangladesh BGD 1991 0.78603 0.02315 0.1015 0.31037 0.36177 Indoor 

Bangladesh BGD 1992 0.74865 0.0237 0.10312 0.31068 0.35861 Indoor 

Bangladesh BGD 1993 0.71297 0.02327 0.10225 0.30689 0.35265 Indoor 

Bangladesh BGD 1994 0.67919 0.0232 0.10191 0.3045 0.34685 Indoor 

Bangladesh BGD 1995 0.6489 0.02301 0.10489 0.31197 0.34852 Indoor 

Bangladesh BGD 1996 0.61862 0.02256 0.1032 0.30753 0.34099 Indoor 

Bangladesh BGD 1997 0.58724 0.02096 0.1009 0.30041 0.33714 Indoor 

Bangladesh BGD 1998 0.55221 0.01864 0.09812 0.29531 0.34817 Indoor 

Bangladesh BGD 1999 0.51995 0.01666 0.09635 0.29425 0.36334 Indoor 

Bangladesh BGD 2000 0.49099 0.01702 0.10076 0.30528 0.37675 Indoor 

Bangladesh BGD 2001 0.4639 0.01608 0.10188 0.30925 0.38559 Indoor 

Bangladesh BGD 2002 0.44129 0.01488 0.10261 0.32119 0.40801 Indoor 

Bangladesh BGD 2003 0.41699 0.01379 0.10371 0.33579 0.4268 Indoor 

Bangladesh BGD 2004 0.39168 0.01358 0.10515 0.34807 0.43569 Indoor 

Bangladesh BGD 2005 0.36474 0.01404 0.10938 0.3663 0.45126 Indoor 

Bangladesh BGD 2006 0.33667 0.01364 0.11283 0.38158 0.46718 Indoor 

Bangladesh BGD 2007 0.31506 0.01356 0.11265 0.38807 0.46475 Indoor 

Bangladesh BGD 2008 0.28827 0.01353 0.11101 0.38489 0.45767 Indoor 

Bangladesh BGD 2009 0.26135 0.01271 0.10767 0.38475 0.46142 Indoor 

Bangladesh BGD 2010 0.23806 0.0111 0.10151 0.38695 0.47158 Indoor 
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Bangladesh BGD 2011 0.21706 0.0094 0.09645 0.37085 0.42765 Indoor 

Bangladesh BGD 2012 0.19238 0.00829 0.09588 0.35589 0.3889 Indoor 

Bangladesh BGD 2013 0.17032 0.00756 0.09115 0.34334 0.39075 Indoor 

Bangladesh BGD 2014 0.15144 0.00707 0.08613 0.33433 0.41302 Indoor 

Bangladesh BGD 2015 0.13534 0.00642 0.08462 0.32883 0.40903 Indoor 

Bangladesh BGD 2016 0.12238 0.00591 0.08289 0.32829 0.42192 Indoor 

Bangladesh BGD 2017 0.10888 0.00558 0.08202 0.33125 0.46056 Indoor 

Bangladesh BGD 2018 0.0954 0.00506 0.08026 0.32663 0.46612 Indoor 

Bangladesh BGD 2019 0.08345 0.00451 0.07726 0.31675 0.46592 Indoor 

Bhutan BTN 1990 0.00408 0.00003 0.00044 0.00158 0.00157 Indoor 

Bhutan BTN 1991 0.00378 0.00003 0.00043 0.00161 0.00163 Indoor 

Bhutan BTN 1992 0.00342 0.00002 0.00043 0.00162 0.00168 Indoor 

Bhutan BTN 1993 0.00319 0.00002 0.00043 0.00164 0.00174 Indoor 

Bhutan BTN 1994 0.00301 0.00003 0.00043 0.00165 0.0018 Indoor 

Bhutan BTN 1995 0.00288 0.00003 0.00043 0.00166 0.00185 Indoor 

Bhutan BTN 1996 0.0028 0.00003 0.00042 0.00163 0.0019 Indoor 

Bhutan BTN 1997 0.00273 0.00003 0.00042 0.00163 0.00197 Indoor 

Bhutan BTN 1998 0.0026 0.00003 0.00042 0.00162 0.00204 Indoor 

Bhutan BTN 1999 0.00235 0.00002 0.0004 0.00157 0.00209 Indoor 

Bhutan BTN 2000 0.00224 0.00002 0.00041 0.00157 0.00216 Indoor 

Bhutan BTN 2001 0.00207 0.00002 0.00039 0.00153 0.00219 Indoor 

Bhutan BTN 2002 0.00185 0.00002 0.00037 0.00148 0.00221 Indoor 

Bhutan BTN 2003 0.00168 0.00002 0.00036 0.00145 0.00222 Indoor 

Bhutan BTN 2004 0.00149 0.00002 0.00035 0.0014 0.00222 Indoor 

Bhutan BTN 2005 0.00131 0.00001 0.00033 0.00136 0.00221 Indoor 

Bhutan BTN 2006 0.00111 0.00001 0.00032 0.00131 0.00219 Indoor 

Bhutan BTN 2007 0.00106 0.00001 0.0003 0.00125 0.00215 Indoor 

Bhutan BTN 2008 0.00094 0.00001 0.00029 0.0012 0.00211 Indoor 

Bhutan BTN 2009 0.00083 0.00001 0.00028 0.00116 0.00207 Indoor 

Bhutan BTN 2010 0.00075 0.00001 0.00027 0.00112 0.00204 Indoor 

Bhutan BTN 2011 0.00068 0.00001 0.00027 0.00109 0.00202 Indoor 

Bhutan BTN 2012 0.00061 0.00001 0.00026 0.00107 0.002 Indoor 

Bhutan BTN 2013 0.00056 0.00001 0.00025 0.00105 0.00198 Indoor 

Bhutan BTN 2014 0.00051 0.00001 0.00025 0.00103 0.00197 Indoor 

Bhutan BTN 2015 0.00047 0.00001 0.00025 0.00102 0.00197 Indoor 

Bhutan BTN 2016 0.00042 0.00001 0.00024 0.00102 0.00198 Indoor 

Bhutan BTN 2017 0.00038 0.00001 0.00024 0.00102 0.00199 Indoor 

Bhutan BTN 2018 0.00035 0.00001 0.00024 0.00101 0.00199 Indoor 

Bhutan BTN 2019 0.00031 0.00001 0.00023 0.001 0.00197 Indoor 

Cambodia KHM 1990 0.12688 0.00297 0.0135 0.03668 0.03465 Indoor 

Cambodia KHM 1991 0.12431 0.00298 0.01361 0.03675 0.03542 Indoor 
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Cambodia KHM 1992 0.1215 0.00299 0.01379 0.03686 0.03636 Indoor 

Cambodia KHM 1993 0.11801 0.00299 0.01417 0.03713 0.03751 Indoor 

Cambodia KHM 1994 0.1141 0.00298 0.01452 0.03763 0.03863 Indoor 

Cambodia KHM 1995 0.10957 0.00296 0.0148 0.03804 0.03973 Indoor 

Cambodia KHM 1996 0.10397 0.00291 0.01498 0.0381 0.04068 Indoor 

Cambodia KHM 1997 0.0979 0.00283 0.01511 0.03814 0.04165 Indoor 

Cambodia KHM 1998 0.09178 0.00275 0.01519 0.03848 0.04273 Indoor 

Cambodia KHM 1999 0.08578 0.00263 0.01532 0.03862 0.04379 Indoor 

Cambodia KHM 2000 0.07929 0.00244 0.01528 0.03857 0.04479 Indoor 

Cambodia KHM 2001 0.07358 0.00232 0.01528 0.03849 0.04577 Indoor 

Cambodia KHM 2002 0.06888 0.00224 0.01516 0.03826 0.04672 Indoor 

Cambodia KHM 2003 0.0633 0.00207 0.01499 0.03813 0.04762 Indoor 

Cambodia KHM 2004 0.05784 0.0019 0.01488 0.03809 0.04858 Indoor 

Cambodia KHM 2005 0.05286 0.00172 0.01467 0.03801 0.04952 Indoor 

Cambodia KHM 2006 0.04807 0.00151 0.01432 0.03791 0.05046 Indoor 

Cambodia KHM 2007 0.04389 0.00137 0.01413 0.03814 0.0514 Indoor 

Cambodia KHM 2008 0.04012 0.00122 0.01384 0.03851 0.05238 Indoor 

Cambodia KHM 2009 0.03658 0.00108 0.0136 0.03901 0.05356 Indoor 

Cambodia KHM 2010 0.03386 0.00098 0.01347 0.03985 0.05495 Indoor 

Cambodia KHM 2011 0.03104 0.00087 0.01324 0.04078 0.05638 Indoor 

Cambodia KHM 2012 0.02915 0.00082 0.01306 0.04162 0.05734 Indoor 

Cambodia KHM 2013 0.02696 0.00076 0.01289 0.04276 0.05806 Indoor 

Cambodia KHM 2014 0.02547 0.00074 0.01275 0.04382 0.05873 Indoor 

Cambodia KHM 2015 0.02379 0.00069 0.01258 0.04488 0.05931 Indoor 

Cambodia KHM 2016 0.02206 0.00065 0.01246 0.046 0.06004 Indoor 

Cambodia KHM 2017 0.02023 0.00061 0.01228 0.04701 0.06091 Indoor 

Cambodia KHM 2018 0.01863 0.00058 0.01212 0.04742 0.06225 Indoor 

Cambodia KHM 2019 0.01711 0.00054 0.0119 0.04791 0.06289 Indoor 

China CHN 1990 1.8111 0.0384 0.86642 4.04788 6.53448 Indoor 

China CHN 1991 1.71951 0.03729 0.85869 3.94438 6.51949 Indoor 

China CHN 1992 1.59534 0.03612 0.84977 3.84136 6.50681 Indoor 

China CHN 1993 1.44905 0.03462 0.83807 3.72607 6.47052 Indoor 

China CHN 1994 1.3043 0.03555 0.86065 3.53887 6.34437 Indoor 

China CHN 1995 1.1596 0.03561 0.87594 3.35718 6.20729 Indoor 

China CHN 1996 1.02091 0.03351 0.85991 3.21171 6.09552 Indoor 

China CHN 1997 0.88487 0.03059 0.83152 3.03681 5.90434 Indoor 

China CHN 1998 0.75854 0.02753 0.81995 2.88179 5.70183 Indoor 

China CHN 1999 0.64353 0.02382 0.79152 2.78796 5.61931 Indoor 

China CHN 2000 0.54452 0.02023 0.77622 2.72486 5.60497 Indoor 

China CHN 2001 0.45588 0.01651 0.73601 2.64729 5.52679 Indoor 

China CHN 2002 0.38027 0.01244 0.68082 2.65114 5.43943 Indoor 
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China CHN 2003 0.31545 0.00934 0.6202 2.63829 5.35134 Indoor 

China CHN 2004 0.26736 0.00763 0.58467 2.5801 5.29614 Indoor 

China CHN 2005 0.22667 0.00635 0.54317 2.42714 5.1059 Indoor 

China CHN 2006 0.19099 0.0052 0.49836 2.22649 4.71026 Indoor 

China CHN 2007 0.1598 0.00435 0.46477 2.04953 4.38331 Indoor 

China CHN 2008 0.13572 0.004 0.44443 1.90119 4.15272 Indoor 

China CHN 2009 0.11543 0.0038 0.42652 1.76506 3.96901 Indoor 

China CHN 2010 0.09694 0.00324 0.41168 1.66024 3.81656 Indoor 

China CHN 2011 0.0852 0.00274 0.38732 1.58556 3.60855 Indoor 

China CHN 2012 0.07725 0.00232 0.35597 1.50655 3.35002 Indoor 

China CHN 2013 0.06687 0.00201 0.32952 1.42124 3.15955 Indoor 

China CHN 2014 0.0573 0.00169 0.30302 1.35375 3.00059 Indoor 

China CHN 2015 0.05556 0.00143 0.27657 1.30102 2.84468 Indoor 

China CHN 2016 0.05364 0.00125 0.25707 1.26609 2.77103 Indoor 

China CHN 2017 0.04403 0.00109 0.23793 1.21825 2.68516 Indoor 

China CHN 2018 0.03545 0.00094 0.21308 1.1458 2.54287 Indoor 

China CHN 2019 0.02872 0.0008 0.18583 1.04555 2.36938 Indoor 
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